Release Notes for ADSP-CM41x EZ-Kit Lite® Board Support Package 1.3.0 For Keil MDK

Release Notes for ADSP-CM41x EZ-Kit Lite® Board Support Package 1.3.0 For Keil MDK

Version , December 2017
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.5.3</td>
<td>Source files for drivers and services</td>
<td>26</td>
</tr>
<tr>
<td>9.5.4</td>
<td>Toolchain Support Files</td>
<td>26</td>
</tr>
<tr>
<td>9.5.5</td>
<td>Additional Utilities</td>
<td>27</td>
</tr>
<tr>
<td>9.5.6</td>
<td>Documentation</td>
<td>27</td>
</tr>
<tr>
<td>9.5.7</td>
<td>Examples</td>
<td>27</td>
</tr>
<tr>
<td>9.5.8</td>
<td>Location</td>
<td>29</td>
</tr>
<tr>
<td>9.6</td>
<td>Contacting Technical Support</td>
<td>29</td>
</tr>
<tr>
<td>9.7</td>
<td>Known issues with the ADSP-CM41x EZ-Kit Lite Board Support Package</td>
<td>29</td>
</tr>
<tr>
<td>9.7.1</td>
<td>ADUCK06-118</td>
<td>29</td>
</tr>
</tbody>
</table>
Thank you for installing the ADSP-CM41x EZ-Kit Lite® Board Support Package (BSP). The BSP provides software and documentation in support of the ADSP-CM41x EZ-Kit Lite.

The Board Support Package is designed to work with Keil MDK embedded software development tools. For more details on Keil, please visit http://www.keil.com The ADSP-CM41x EZ-Kit Lite BSP provides comprehensive software support for the ADSP-CM41x EZ-Kit Lite which includes drivers and services. The BSP also provides comprehensive examples which demonstrate the on-chip drivers and services. The documentation for the device drivers and services is included in the BSP.
1 Release Dependencies

- Requires Keil MDK version 5.18a or later.
- Requires Segger J-Link USB drivers version 6.14c.
2 Release Testing

The BSP has been tested with the ADSP-CM419F EZ-KIT Lite BOM 1.4
3 License Checking

The BSP software does not perform any license checking. Use of the BSP software is subject to the Software License Agreement presented during installation.
4 Installation Steps

This BSP can be obtained and installed in two ways:

1. From www.analog.com. This requires a separate installation step.
2. Directly within the Keil MDK uVision tools.

4.1 From www.analog.com

The BSP consists of a PACK file. This PACK files can be obtained from www.analog.com, as a zip file.
5 To complete the installation, perform the following steps:

1. Extract the zip file contents into a temporary directory of your choice.
2. Open the Keil MDK uVision IDE.
3. Invoke the Keil Pack Installer.
4. Import the ADSP-CM4xx Pack:
   a. Do File > Import
   b. In the Import Packs pop-up dialog, browse to the directory specified during installation.
   c. Select the AnalogDevices.CM4xx_DFP.1.3.0.pack file.
   d. Click Open.
   e. After importing is complete, Analog Devices ARM Cortex-M0 and Cortex-M4 CM4xx Family Device Support will be listed in the Packs tab, as Offline (as the pack was installed from a file, not downloaded directly).
5. Once PACK files is installed, you may remove the temporary directory.

5.1 Directly within the Keil MDK uVision tools.

PACK files for Analog Devices Cortex-M-based processors may be obtained directly from within the Keil MDK uVision tools.

1. Launch the Keil uVision IDE.
2. Click on the Pack Installer icon.
3. In the Pack Installer, select Packs > Check for Updates.
4. In the Device tab, select AnalogDevices, then CM41x Mixed-Signal Processors.
5. In the Packs tab, under Device Specific, select AnalogDevices::CM4xx_DFP, and click on Install.

5.2 Release Content

This release contains the follows sets of components:

- Source files for device drivers and services. These components are authored by Analog Devices, for use on the ADSP-CM41x processor.
Examples for device drivers and services. These components are authored by Analog Devices, and demonstrate the use of the device drivers and services.

Toolchain support. These components are authored by Analog Devices, and are installed into the toolchain to configure it to recognize the ADSP-CM41x processor family.

Additional utilities. These components are authored by Analog Devices, and assist in the generation of applications for the ADSP-CM41x processor family.

Documentation

5.3 Source files for drivers and services

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>adi_int, adi_nvic</td>
<td>Source files and include files</td>
</tr>
<tr>
<td>adi_types.h</td>
<td>Base typedefs</td>
</tr>
<tr>
<td><em>ADSP-CM41x</em>.h</td>
<td>Device descriptions and macro files</td>
</tr>
<tr>
<td>System</td>
<td>Source files and include files</td>
</tr>
<tr>
<td>Startup</td>
<td>Source files and include files</td>
</tr>
</tbody>
</table>

Various peripheral device driver sources and include files in the “src” and “inc” directories.

5.4 Toolchain Support Files

The following common system infrastructure framework files are installed in the toolchain and should be used in all projects.

5.4.1 Keil MDK Tool Chain Configuration files

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM41x_M0.svd, CM41x_M4.svd</td>
<td>Debugger register display</td>
</tr>
<tr>
<td>CM41x_FlashA_512.FLM</td>
<td>Flash loader files</td>
</tr>
<tr>
<td>CM41x_FlashB_512.FLM</td>
<td></td>
</tr>
</tbody>
</table>
5.5 Additional Utilities

This utility is installed into the tools subdirectory

| PinMuxUI | Graphical pin mux configuration and code generation utility |

5.6 Documentation

<table>
<thead>
<tr>
<th>ADSP-CM41x_Software_for_MDK_Keil_ReleaseNotes.pdf (this file)</th>
<th>Release Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>html/index.html</td>
<td>Index file for HTML-based Device Driver API documentation.</td>
</tr>
<tr>
<td>CM41x_Device_Drivers_User_Guide.pdf</td>
<td>Provides the guidelines for using the Analog Devices device drivers</td>
</tr>
<tr>
<td>ADSP-CM41x_EZ-Kit_Lite_BSP_UsersGuide.pdf</td>
<td>Provides the details about ADSP-CM41x EZ-KIT Lite® Board Support Package (BSP) and its use</td>
</tr>
</tbody>
</table>

5.7 Examples

ADSP-CM41x processors are dual-core processors, with both a Cortex-M4 core and a Cortex-M0 core. The majority of examples are single-core examples, configured to be built for one core or the other; several of the examples are supplied in two configurations, one for each core. The “mbox” examples are dual-core examples: there is a project for each core, and the complete example consists of both projects, running simultaneously on different cores of the same processor.

Please note that examples which runs the Cortex-M0 core of the ADSP-CM41x processor will output all debug information to UART0 which is connected to J9 (RS232 Terminal). Please refer to the readme and ADSP-CM41x_EZ-Kit_Lite_BSP_UsersGuide.pdf for more details.
This example allows you to test the many peripherals of the ADSP-CM41x EZ-Kit Lite. This example is also pre-programmed into the on-board flash memory. By following the instruction in the Readme_post.html file, you can also program this example into the EZ-Kit flash. This POST was designed so that you can use the ADSP-CM41x push buttons to select a specific test to run. The POST example is located in the examples directory:
Boards\AnalogDevices\ADSP-CM419x-EZ-BOARD\Power_On_Self_Test

5.7.1 ProgramInfoSpace

This example contains several projects which demonstrate how the "info space" areas of the flash memories can be reprogrammed to specific values. This is necessary in order to lock the device to protect IP programmed into the main flash memories, and to enable CRC-checking of flash memory. The example contains the following projects:

1. An application to report the state of the info space.
2. An application to erase and unlock a part with corrupted security information, returning it to "clean", empty state.
3. An application to apply configuration data. This application can also enable flash integrity CRC checks.

5.7.2 Examples for Services Added

<table>
<thead>
<tr>
<th>1</th>
<th>Floating Point Saturation Unit (FSAT)</th>
<th>Cortex-M4</th>
<th>Demonstrates the Floating Point Saturation Unit.</th>
</tr>
</thead>
</table>

5.8 Location

By default, the BSP software will be installed at the following location as standard Keil pack files:
C:\Keil_v5\ARM\Pack\AnalogDevices
6 Contacting Technical Support

Submit your questions online at:
http://www.analog.com/support

E-mail your Processors and DSP applications and processor questions to:
processor.support@analog.com OR
processor.china@analog.com (Greater China support)
For MDK Keil tool chain support please visit
http://www.keil.com/support
7 Known issues with the ADSP-CM41x EZ-Kit Lite Board Support Package

- It is advisable to use reset the board using SW6 before loading stand-alone M4 or M0 examples to prevent any error while loading.
- ADUCK06-118: Provide Part Specific Configurations in the ADSP-CM41x PinMux UI (see below)
- ADUCK06-190: Default project needs Dbg_cm4.ini
- ADUCK06-95: SVD files do not identify <readAction> for registers or fields
- ADUCK06-222: Installation path name is not correct

7.1 ADUCK06-118

The Pin Multiplexing Tool is available to assist in building pin multiplexing applications for the ADSP-CM41x family. The 1.0.0 release provides a single generic family part ADSP-CM41x, fully configured for the 210 Ball BGA with 5 UARTs and 16 GP timers.

This matches the full configuration available with the ADSP-CM418F/ADSP-CM419F generic parts.

Some pin selections will not be valid for parts that do not support this full configuration.

Note that the ADSP-CM411F and ADSP-CM412F reduce the number of UARTs and the ADSP-CM411F, ADSP-CM412F and ADSP-CM413F reduce the number of GP timers.

Consult the Product Features table in the ADSP-CM41x Mix-Signal Control Processor datasheet which describes the features available for each of the generic parts:

- ADSP-CM411F
- ADSP-CM412F
- ADSP-CM413F
- ADSP-CM416F
- ADSP-CM417F
- ADSP-CM418F
- ADSP-CM419F
7.2 ADUCK06-190

The example projects in the pack include a Dbg_cm4.ini file, which is referenced in the Initialization File field of the Options > Debug tab. A default project doesn't have this file, which means that the PC is not pointing at the start of main() when you load a project into the board using the debugger. Hence Dbg_cm4.ini and Dbg_cm0.ini files are required for default Cortex-M4 and Cortex-M0 projects respectively.

7.3 ADUCK06-222

After installing AnalogDevices.CM4xx_DFP.1.3.0.pack, the installation path shows “C:\Keil_v5\ARM\PACK\AnalogDevices\CM4xx_DFP\1.3.0\Boards\AnalogDevices\ADSP-CM419x-EZ-BOARD”. It should be updated to “C:\Keil_v5\ARM\PACK\AnalogDevices\CM4xx_DFP\1.3.0\Boards\AnalogDevices\ADSP-CM419F-EZ-BOARD”
Thank you for installing the ADSP-CM41x EZ-Kit Lite® Board Support Package (BSP). The BSP provides software and documentation in support of the ADSP-CM41x EZ-Kit Lite.

The Board Support Package is designed to work with Keil MDK embedded software development tools. For more details on Keil, please visit [http://www.keil.com](http://www.keil.com) The ADSP-CM41x EZ-Kit Lite BSP provides comprehensive software support for the ADSP-CM41x EZ-Kit Lite which includes drivers and services. The BSP also provides comprehensive examples which demonstrate the on-chip drivers and services. The documentation for the device drivers and services is included in the BSP.

For Release 1.2.0, the two separate PACK files, ADSP-CM41x-M0 and ADSP-CM41x-M4, have been merged into one PACK file as ADSP-CM4xx.

### 8.1 Release Dependencies

- Requires Keil MDK version 5.18a or later.
- Requires Segger J-Link USB drivers version 6.14c.

### 8.2 Release Testing

The BSP has been tested with the ADSP-CM419F EZ-KIT Lite BOM 1.2.

### 8.3 License Checking

The BSP software does not perform any license checking. Use of the BSP software is subject to the Software License Agreement presented during installation.

### 8.4 Installation Steps

This BSP can be obtained and installed in two ways:

1. From [www.analog.com](http://www.analog.com). This requires a separate installation step.
2. Directly within the Keil MDK uVision tools.
8.4.1 From www.analog.com

The BSP consists of a PACK file. This PACK files can be obtained from www.analog.com, as a zip file.

8.5 To complete the installation, perform the following steps:

1. Extract the zip file contents into a temporary directory of your choice.
2. Open the Keil MDK uVision IDE.
3. Invoke the Keil Pack Installer.
4. Import the ADSP-CM4xx Pack:
   a. Do File > Import
   b. In the Import Packs pop-up dialog, browse to the directory specified during installation.
   c. Select the AnalogDevices.CM4xx_DFP.1.2.0.pack file.
   d. Click Open.
   e. After importing is complete, Analog Devices ARM Cortex-M0 and Cortex-M4 CM4xx Family Device Support will be listed in the Packs tab, as Offline (as the pack was installed from a file, not downloaded directly).
5. Once PACK files is installed, you may remove the temporary directory.

8.5.1 Directly within the Keil MDK uVision tools.

PACK files for Analog Devices Cortex-M-based processors may be obtained directly from within the Keil MDK uVision tools.

1. Launch the Keil uVision IDE.
2. Click on the Pack Installer icon.
3. In the Pack Installer, select Packs > Check for Updates.
4. In the Device tab, select AnalogDevices, then CM41x Mixed-Signal Processors.
5. In the Packs tab, under Device Specific, select AnalogDevices::CM4xx_DFP, and click on Install.

8.5.2 Release Content

This release contains the follows sets of components:
• Source files for device drivers and services. These components are authored by Analog Devices, for use on the ADSP-CM41x processor.

• Examples for device drivers and services. These components are authored by Analog Devices, and demonstrate the use of the device drivers and services.

• Toolchain support. These components are authored by Analog Devices, and are installed into the toolchain to configure it to recognize the ADSP-CM41x processor family.

• Additional utilities. These components are authored by Analog Devices, and assist in the generation of applications for the ADSP-CM41x processor family.

• Documentation

### 8.5.3 Source files for drivers and services

<table>
<thead>
<tr>
<th>Source files and include files</th>
<th>Base typedefs</th>
</tr>
</thead>
<tbody>
<tr>
<td>adi_int, adi_nvic</td>
<td>adi_types.h</td>
</tr>
<tr>
<td>System</td>
<td><em>ADSP-CM41x</em>.h</td>
</tr>
<tr>
<td>Startup</td>
<td>Source files and include files</td>
</tr>
</tbody>
</table>

Various peripheral device driver sources and include files in the “src” and “inc” directories.

### 8.5.4 Toolchain Support Files

The following common system infrastructure framework files are installed in the toolchain and should be used in all projects.

#### Keil MDK Tool Chain Configuration files

<table>
<thead>
<tr>
<th>Debugger register display</th>
<th>Flash loader files</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM41x_M0.svd, CM41x_M4.svd</td>
<td>CM41x_FlashA_512.FLM</td>
</tr>
<tr>
<td></td>
<td>CM41x_FlashB_512.FLM</td>
</tr>
</tbody>
</table>
8.5.5 Additional Utilities

This utility is installed into the tools subdirectory

| PinMuxUI | Graphical pin mux configuration and code generation utility |

8.5.6 Documentation

| ADSP-CM41x_Software_for_MDK_Keil_ReleaseNotes.pdf (this file) | Release Notes |
| html/index.html | Index file for HTML-based Device Driver API documentation. |
| CM41x_Device_Drivers_User_Guide.pdf | Provides the guidelines for using the Analog Devices device drivers |
| ADSP-CM41x_EZ-Kit_Lite_BSP_UsersGuide.pdf | Provides the details about ADSP-CM41x EZ-KIT Lite® Board Support Package (BSP) and its use |

8.5.7 Examples

ADSP-CM41x processors are dual-core processors, with both a Cortex-M4 core and a Cortex-M0 core. The majority of examples are single-core examples, configured to be built for one core or the other; several of the examples are supplied in two configurations, one for each core. The “mbox” examples are dual-core examples: there is a project for each core, and the complete example consists of both projects, running simultaneously on different cores of the same processor.

Please note that examples which runs the Cortex-M0 core of the ADSP-CM41x processor will output all debug information to UART0 which is connected to J9 (RS232 Terminal). Please refer to the readme and ADSP-CM41x_EZ-Kit_Lite_BSP_UsersGuide.pdf for more details.

Power_On_Self_Test

This example allows you to test the many peripherals of the ADSP-CM41x EZ-Kit Lite. This example is also pre-programmed into the on-board flash memory. By following the instruction in the Readme_post.html file, you can also program this example into the EZ-Kit flash. This POST was designed so that you can use the ADSP-CM41x push buttons to select a specific test to run. The POST example is located in the examples directory:

Boards\AnalogDevices\ADSP-CM41x-EZ-BOARD\Power_On_Self_Test
ProgramInfoSpace

This example contains several projects which demonstrate how the "info space" areas of the flash memories can be reprogrammed to specific values. This is necessary in order to lock the device to protect IP programmed into the main flash memories, and to enable CRC-checking of flash memory. The example contains the following projects:

1. An application to report the state of the info space.
2. An application to erase and unlock a part with corrupted security information, returning it to "clean", empty state.
3. An application to apply configuration data. This application can also enable flash integrity CRC checks.
**Examples / Drivers Added**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DBC</td>
<td>Cortex-M4</td>
</tr>
<tr>
<td>2</td>
<td>Rotary Counter</td>
<td>Cortex M4</td>
</tr>
<tr>
<td>3</td>
<td>CRC</td>
<td>Cortex M0</td>
</tr>
<tr>
<td>4</td>
<td>DACC</td>
<td>Cortex M0</td>
</tr>
<tr>
<td>5</td>
<td>TTU</td>
<td>Cortex M0</td>
</tr>
<tr>
<td>6</td>
<td>TWI</td>
<td>Cortex M0</td>
</tr>
<tr>
<td>8</td>
<td>OCU</td>
<td>Cortex M4, Cortex M0</td>
</tr>
<tr>
<td>9</td>
<td>FOCP</td>
<td>Cortex M4</td>
</tr>
<tr>
<td>10</td>
<td>FFTB</td>
<td>Cortex M4</td>
</tr>
<tr>
<td>11</td>
<td>HAE</td>
<td>Cortex M0, Cortex M4</td>
</tr>
<tr>
<td>12</td>
<td>SINC</td>
<td>Cortex M4</td>
</tr>
</tbody>
</table>
Examples for Services Added

<table>
<thead>
<tr>
<th></th>
<th>Example</th>
<th>Cortex-M0</th>
<th>Cortex-M4</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>WatchDog Timer</td>
<td></td>
<td></td>
<td>Demonstrates the WatchDog Timer module.</td>
</tr>
<tr>
<td>2</td>
<td>Capture Timer</td>
<td></td>
<td>Cortex-M4</td>
<td>Demonstrates the Capture Timer module.</td>
</tr>
<tr>
<td>3</td>
<td>ROM API's</td>
<td>Cortex-M4</td>
<td></td>
<td>Demonstrates the usage of ROM API's</td>
</tr>
<tr>
<td>4</td>
<td>SPU</td>
<td>Cortex-M0</td>
<td>Cortex-M4</td>
<td>Demonstrates the SPU module.</td>
</tr>
</tbody>
</table>

8.5.8 Location

By default, the BSP software will be installed at the following location as standard Keil pack files:
C:\Keil_v5\ARM\Pack\AnalogDevices

8.6 Contacting Technical Support

Submit your questions online at:
http://www.analog.com/support

E-mail your Processors and DSP applications and processor questions to:
processor.support@analog.com OR
processor.china@analog.com (Greater China support)

For MDK Keil tool chain support please visit
http://www.keil.com/support

8.7 Known issues with the ADSP-CM41x EZ-Kit Lite Board Support Package

- It is advisable to user to reset the board using SW6 before loading stand-alone M4 or M0 examples to prevent any error while loading.
- ADUCK06-118: Provide Part Specific Configurations in the ADSP-CM41x PinMux UI (see below)
- ADUCK06-190: Default project needs Dbg_cm4.ini
8.7.1 ADUCK06-118

The Pin Multiplexing Tool is available to assist in building pin multiplexing applications for the ADSP-CM41x family. The 1.0.0 release provides a single generic family part ADSP-CM41x, fully configured for the 210 Ball BGA with 5 UARTs and 16 GP timers.

This matches the full configuration available with the ADSP-CM418F/ADSP-CM419F generic parts.

Some pin selections will not be valid for parts that do not support this full configuration.

Note that the ADSP-CM411F and ADSP-CM412F reduce the number or UARTs and the ADSP-CM411F, ADSP-CM412F and ADSP-CM413F reduce the number of GP timers.

Consult the Product Features table in the ADSP-CM41x Mix-Signal Control Processor datasheet which describes the features available for each of the generic parts:

- ADSP-CM411F
- ADSP-CM412F
- ADSP-CM413F
- ADSP-CM416F
- ADSP-CM417F
- ADSP-CM418F
- ADSP-CM419F

8.7.2 ADUCK06-190

The example projects in the pack include a Dbg_cm4.ini file, which is referenced in the Initialization File field of the Options > Debug tab. A default project doesn't have this file, which means that the PC is not pointing at the start of main() when you load a project into the board using the debugger. Hence Dbg_cm4.ini and Dbg_cm0.ini files are required for default Cortex-M4 and Cortex-M0 projects respectively.
9 Release Notes for ADSP-CM41x EZ-Kit Lite® Board Support Package 1.0.0 For Keil MDK

Thank you for installing the ADSP-CM41x EZ-Kit Lite® Board Support Package (BSP). The BSP provides software and documentation in support of the ADSP-CM41x EZ-Kit Lite.

The Board Support Package is designed to work with Keil MDK embedded software development tools. For more details on Keil, please visit http://www.keil.com The ADSP-CM41x EZ-Kit Lite BSP provides comprehensive software support for the ADSP-CM41x EZ-Kit Lite which includes drivers and services. The BSP also provides comprehensive examples which demonstrate the on-chip drivers and services. The documentation for the device drivers and services is included in the BSP.

9.1 Release Dependencies

- Requires Keil MDK version 5.17 or later.
- Requires Segger J-Link USB drivers version 5.10p.

9.2 Release Testing

The BSP has been tested with the ADSP-CM419F EZ-KIT Lite BOM 1.2

9.3 License Checking

The BSP software does not perform any license checking. Use of the BSP software is subject to the Software License Agreement presented during installation.

9.4 Installation Steps

This BSP can be obtained and installed in two ways:

1. From www.analog.com. This requires a separate installation step.
2. Directly within the Keil MDK uVision tools.
9.4.1 From **www.analog.com**

The BSP consists of two separate PACK files, one for each ARM core on the ADSP-CM41x processor. These two PACK files can be obtained from **www.analog.com**, as a zip file.

9.5 To complete the installation, perform the following steps:

1. Extract the zip file contents into a temporary directory of your choice.
2. Open the Keil MDK uVision IDE.
3. Invoke the Keil Pack Installer.
4. Import the ADSP-CM41x-M0 Pack:
   a. Do File > Import
   b. In the Import Packs pop-up dialog, browse to the directory specified during installation.
   c. Select the `AnalogDevices.CM41x_M0_DFP.1.0.0.pack` file.
   d. Click Open.
   e. After importing is complete, *Analog Devices ARM Cortex-M0 CM41x Family Device Support* will be listed in the Packs tab, as Offline (as the pack was installed from a file, not downloaded directly).
5. Repeat these steps for the `AnalogDevices.CM41x_M4_DFP.1.0.0.pack` file.
6. Once both PACK files are installed, you may remove the temporary directory.

9.5.1 Directly within the Keil MDK uVision tools.

PACK files for Analog Devices Cortex-M-based processors may be obtained directly from within the Keil MDK uVision tools.

1. Launch the Keil uVision IDE.
2. Click on the Pack Installer icon.
3. In the Pack Installer, select *Packs > Check for Updates*.
4. In the Device tab, select AnalogDevices, then CM41x Mixed-Signal Processors.
5. In the Packs tab, under Device Specific, select AnalogDevices::CM41x_M0_DFP, and click on *Install*.
6. In the Packs tab, under Device Specific, select AnalogDevices::CM41x_M4_DFP, and click on *Install*. 
9.5.2 Release Content

This release contains the following sets of components:

- Source files for device drivers and services. These components are authored by Analog Devices, for use on the ADSP-CM41x processor.
- Examples for device drivers and services. These components are authored by Analog Devices, and demonstrate the use of the device drivers and services.
- Toolchain support. These components are authored by Analog Devices, and are installed into the toolchain to configure it to recognize the ADSP-CM41x processor family.
- Additional utilities. These components are authored by Analog Devices, and assist in the generation of applications for the ADSP-CM41x processor family.
- Documentation

9.5.3 Source files for drivers and services

<table>
<thead>
<tr>
<th>Source files and include files</th>
<th>Source files and include files</th>
</tr>
</thead>
<tbody>
<tr>
<td>adi_int, adi_nvic</td>
<td>Source files and include files</td>
</tr>
<tr>
<td>adi_types.h</td>
<td>Base typedefs</td>
</tr>
<tr>
<td>ADSP-CM41x*.h</td>
<td>Device descriptions and macro files</td>
</tr>
<tr>
<td>System</td>
<td>Source files and include files</td>
</tr>
<tr>
<td>Startup</td>
<td>Source files and include files</td>
</tr>
</tbody>
</table>

Various peripheral device driver sources and include files in the “src” and “inc” directories.

9.5.4 Toolchain Support Files

The following common system infrastructure framework files are installed in the toolchain and should be used in all projects.

Keil MDK Tool Chain Configuration files

<table>
<thead>
<tr>
<th>Debugger register display</th>
<th>Flash loader files</th>
</tr>
</thead>
<tbody>
<tr>
<td>CM41x_M0.svd, CM41x_M4.svd</td>
<td>CM41x_FlashA_512.FLM</td>
</tr>
<tr>
<td>CM41x_FlashB_512.FLM</td>
<td></td>
</tr>
</tbody>
</table>
9.5.5 Additional Utilities

This utility is installed into the tools subdirectory

| PinMuxUI       | Graphical pin mux configuration and code generation utility |

9.5.6 Documentation

| ADSP-CM41x_Software_for_MDK_Keil_ReleaseNotes.pdf (this file) | Release Notes |
| html/index.html | Index file for HTML-based Device Driver API documentation. |
| CM41x_Device_Drivers_User_Guide.pdf | Provides the guidelines for using the Analog Devices device drivers |
| ADSP-CM41x_EZ-Kit_Lite_BSP_UsersGuide.pdf | Provides the details about ADSP-CM41x EZ-KIT Lite® Board Support Package (BSP) and its use |

9.5.7 Examples

ADSP-CM41x processors are dual-core processors, with both a Cortex-M4 core and a Cortex-M0 core. The majority of examples are single-core examples, configured to be built for one core or the other; several of the examples are supplied in two configurations, one for each core. The “mbox” examples are dual-core examples: there is a project for each core, and the complete example consists of both projects, running simultaneously on different cores of the same processor.

Please note that examples which runs the Cortex-M0 core of the ADSP-CM41x processor will output all debug information to UART0 which is connected to J9 (RS232 Terminal). Please refer to the readme and ADSP-CM41x_EZ-Kit_Lite_BSP_UsersGuide.pdf for more details.

ProgramInfoSpace

This example contains several projects which demonstrate how the "info space" areas of the flash memories can be reprogrammed to specific values. This is necessary in order to lock the device to protect IP programmed into the main flash memories, and to enable CRC-checking of flash memory. The example contains the following projects:

1. An application to report the state of the info space.
2. An application to erase and unlock a part with corrupted security information, returning it to "clean", empty state.

3. An application to apply configuration data. This application can also enable flash integrity CRC checks.

### Examples for Drivers

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CRC</td>
<td>Cortex-M4</td>
</tr>
<tr>
<td>2</td>
<td>UART</td>
<td>Cortex-M0 Cortex-M4</td>
</tr>
<tr>
<td>3</td>
<td>SPI</td>
<td>Cortex-M4</td>
</tr>
<tr>
<td>4</td>
<td>TRU</td>
<td>Cortex-M0 Cortex-M4</td>
</tr>
<tr>
<td>5</td>
<td>TTU</td>
<td>Cortex-M4</td>
</tr>
<tr>
<td>6</td>
<td>Math Unit</td>
<td>Cortex-M4</td>
</tr>
<tr>
<td>8</td>
<td>ADCC</td>
<td>Cortex-M0 Cortex-M4</td>
</tr>
<tr>
<td>9</td>
<td>SPORT</td>
<td>Cortex-M4</td>
</tr>
</tbody>
</table>

### Examples for Services

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Timer</td>
<td>Cortex-M0 Cortex-M4</td>
</tr>
<tr>
<td>2</td>
<td>MDMA</td>
<td>Cortex-M4</td>
</tr>
<tr>
<td>3</td>
<td>SysTick</td>
<td>Cortex-M0 Cortex-M4</td>
</tr>
<tr>
<td>4</td>
<td>GPIO</td>
<td>Cortex-M0 Cortex-M4</td>
</tr>
<tr>
<td>5</td>
<td>MBOX</td>
<td>Cortex-M0 Cortex-M4</td>
</tr>
<tr>
<td>6</td>
<td>SMPU</td>
<td>Cortex-M0 Cortex-M4</td>
</tr>
</tbody>
</table>
9.5.8 Location

By default, the BSP software will be installed at the following location as standard Keil pack files:
C:\Keil_v5\ARM\Pack\AnalogDevices

9.6 Contacting Technical Support

Submit your questions online at:
http://www.analog.com/support

E-mail your Processors and DSP applications and processor questions to:
processor.support@analog.com OR
processor.china@analog.com (Greater China support)

For MDK Keil tool chain support please visit
http://www.keil.com/support

9.7 Known issues with the ADSP-CM41x EZ-Kit Lite Board Support Package

- ADUCK06-116: There is no utility provided for enabling the Cortex-M4 application to program the Cortex-M0’s application image into the appropriate SRAM before releasing the Cortex-M0 core.

- It is advisable to user to reset the board using SW6 before loading stand-alone M4 or M0 examples to prevent any error while loading.

- ADUCK06-67: There is no utility provided for computing a CRC value for supporting flash integrity checks.

- ADUCK06-118: Provide Part Specific Configurations in the ADSP-CM41x PinMux UI (see below)

9.7.1 ADUCK06-118

The Pin Multiplexing Tool is available to assist in building pin multiplexing applications for the ADSP-CM41x family. The 1.0.0 release provides a single generic family part ADSP-CM41x, fully configured for the 210 Ball BGA with 5 UARTs and 16 GP timers.

This matches the full configuration available with the ADSP-CM418F/ADSP-CM419F generic parts.

Some pin selections will not be valid for parts that do not support this full configuration.
Note that the ADSP-CM411F and ADSP-CM412F reduce the number of UARTs and the ADSP-CM411F, ADSP-CM412F and ADSP-CM413F reduce the number of GP timers.

Consult the *Product Features* table in the ADSP-CM41x Mix-Signal Control Processor datasheet which describes the features available for each of the generic parts:

- ADSP-CM411F
- ADSP-CM412F
- ADSP-CM413F
- ADSP-CM416F